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IMPORTANT SAFETY INSTRUCTIONS 
 

 

The lightning flash with arrowhead symbol within an equilateral triangle is 
intended to alert the user to the presence of uninsulated “Dangerous voltage” 
within the product’s enclosure that may be of sufficient magnitude to 
constitute a risk of electric shock to persons. 

 

The exclamation point within an equilateral triangle is intended to alert the 
user to the presence of important operating and maintenance (Servicing) 
instructions in the literature accompanying the product. 

 
• Read these instructions 
• Keep these instructions. 
• Heed all warnings. 
• Follow all instructions. 
• Do not use this apparatus near water 
• Clean only with dry cloth. 
• Do not block any ventilation openings.  Install in accordance with the manufacturer’s instructions. 
• Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus 

(including amplifiers) that produce heat. 
• Do not defeat the safety purpose of the polarized or grounding-type plug.  A polarized plug has two 

blades with one wider than other.  A grounding-type plug has two blades and a third grounding 
prong.  The wide blade or the third prong is provided for your safety.  If the provided plug does not 
fit into your outlet, consult an electrician for replacement of the obsolete outlet. 

• Protect the power cord from being walked on or pinched particularly at plugs, convenience 
receptacles and the point where they exit from the apparatus. 

• Only use attachments/accessories specified by the manufacturer 
• Unplug this apparatus during lightning storms or when unused for long periods of time. 
• Refer all servicing to qualified service personnel.  Servicing is required when the apparatus has 

been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled 
or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does 
not operate normally, or has been dropped. 

 

WARNING 
TO REDUCE THE RISK OF FIRE OR ELECTRIC – SHOCK, DO NOT EXPOSE THIS APPARATUS 
TO RAIN OR MOISTURE 

WARNING 
DO NOT EXPOSE THIS EQUIPMENT TO DRIPPING OR SPLASHING AND ENSURE THAT NO 
OBJECTS FILLED WITH LIQUIDS ARE PLACED ON THE EQUIPMENT 

WARNING  
TO COMPLETELY DISCONNECT THIS EQUIPMENT FROM THE AC MAINS, DISCONNECT THE 
POWER SUPPLY CORD PLUG FROM THE AC RECEPTACLE 

WARNING  
THE MAINS PLUG OF THE POWER SUPPLY CORD SHALL REMAIN READILY OPERABLE 
  



 
 

 

INFORMATION TO USERS IN EUROPE 
 

NOTE 
 

CISPR 22 CLASS A DIGITAL DEVICE OR PERIPHERAL 
 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to the European Union EMC directive.  These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial environment.  
This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used 
in accordance with the instruction manual, may cause harmful interference to radio communications.  
Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense. 
 

 
 

INFORMATION TO USERS IN THE U.S.A. 
 

NOTE 
 

FCC CLASS A DIGITAL DEVICE OR PERIPHERAL 
 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment.  This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications.  
Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense. 

 
WARNING 

 
Changes or Modifications not expressly approved by Evertz Microsystems Ltd. could void the user’s 
authority to operate the equipment. 
 
Use of unshielded plugs or cables may cause radiation interference.  Properly shielded interface 
cables with the shield connected to the chassis ground of the device must be used. 

 
 

 
 
 

 

EN60065 Safety  

 

EN504192 2005 
Waste electrical products should not 
be disposed of with household waste. 

Contact your Local Authority for 
recycling advice 

EN55103-1: 1996 Emission 
EN55103-2: 1996 Immunity 
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Information contained in this manual is believed to be accurate and reliable. However, Evertz assumes no responsibility for the use thereof nor 
for the rights of third parties, which may be affected in any way by the use thereof.  Any representations in this document concerning 
performance of Evertz products are for informational use only and are not warranties of future performance, either expressed or implied. The 
only warranty offered by Evertz in relation to this product is the Evertz standard limited warranty, stated in the sales contract or order 
confirmation form. 
 
Although every attempt has been made to accurately describe the features, installation and operation of this product in this manual, no 
warranty is granted nor liability assumed in relation to any errors or omissions unless specifically undertaken in the Evertz sales contract or 
order confirmation.  Information contained in this manual is periodically updated and changes will be incorporated into subsequent editions.  If 
you encounter an error, please notify Evertz Customer Service department. Evertz reserves the right, without notice or liability, to make 
changes in equipment design or specifications. 
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1. OVERVIEW 

The 7800DA7-MADI reclocking distribution amplifier provides inexpensive distribution of your AES10 
MADI audio signals. The 7800DA7-MADI will automatically equalize MADI signals on Belden 1694A 
coax up to 250m. 
 
The 7800DA7-MADI supports the industry standard 64-channel payload at a sampling rate of 48 kHz. 
Sampling rates up to 96 kHz are also supported at various payload capacities as specified in AES10-
2003. 
 
The 7800DA7-MADI card edge LED indicators provide quick and accurate assessment of the incoming 
signal integrity. 
 
The 7800DA7-MADI occupies one card slot and can be housed in a 1RU frame which will hold up to 4 
modules, a 3RU frame which will hold up to 15 modules, or a 350FR portable frame which will hold up 
to 7 modules. 
 
Features & Benefits 
 

• AES10-2003 standard for MADI audio on 75Ω coax 
• Data reclocking provides jitter reduction 
• Automatic equalization 
• Equalizer and reclocker provide extended cable length compensation (> 250m) 
• Seven 75Ω coax outputs 
• VistaLINK® capable for remote monitoring, control and configuration capabilities via SNMP; using 

VistaLINK®PRO, CP-2116E or CP-2232E Control Panels. VistaLINK® is available when modules 
are used with the 3RU 7800FR frame and a 7700FC VistaLINK® Frame Controller module in slot 
1 of the frame 
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Figure 1-1: 7800DA7-MADI Block Diagram 
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2. GETTING STARTED 

2.1. REAR PANEL DESCRIPTION 
 

 
Figure 2-1: 7800DA7-MADI Rear Panel 

 
MADI INPUT  This BNC accepts the MADI input. 
 
MADI OUTPUT These 7 BNCs distribute the reclocked MADI output.  
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2.2. HARDWARE INSTALLATION 
To successfully install the 7800DA7-MADI, you will require the following: 
 

1. VistaLINK® PRO Server IP address. 
2. 7700 or 7800 Series Frame.  
3. 7700 or 7800 Frame Controller. 

 
 
Before handling the card it is important to minimize the potential effects of static electricity. It is 
therefore recommended that an ESD strap be worn.   
 
Using a 7700/7800 series frame with a frame controller connected to VLPro, locate on the chassis one 
vacant slot. Unpack the 7800DA7-MADI and separate the rear panel from the main card. Locate on the 
rear of the rack the desired slot and remove the blank panel. Insert the rear panel into the back of the 
chassis and secure using the screws provided.  Slide in 7800DA7-MADI module on the corresponding 
slot runners and mate with rear panel. 
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3. TEHCNICAL SPECIFICATIONS 

3.1. MADI INPUT 
Standard:  AES10-2003 
Number of Inputs:  1 
Connector:  BNC  
Input Level:  0.3 – 0.6 V p-p 
Input Impedance:  75Ω 
Equalization:  Automatic to 250m with Belden 1694A (or equivalent) 
Sampling Frequency:  32 kHz, 44.1 kHz, 48 kHz and 96 kHz 
 

3.2. MADI OUTPUT 
Number of Outputs:  7 per card reclocked 
Connector:  BNC  
Output Level:  0.6 V p-p 
Output Impedance:  75Ω 
Jitter:  0.1 UI 
 

3.3. PHYSICAL (NUMBER OF SLOTS) 
350FR:  1 
7700FR-C:  1 
7800FR:  1 
 

3.4. ELECTRICAL 
Voltage:  +12V DC 
Power:  5W 
EMI/RFI:  Complies with FCC Part 15, Class A EU EMC Directive 
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4. CONNECTING TO VLPRO 

This chapter assumes that the VistaLINK® PRO server and client are already configured for your 
network and you have basic knowledge of the VistaLINK® PRO interface. It also assumes that the user 
or network administrator has already added the appropriate jar file to the server, and both the client and 
server applications have been restarted.  If you are the network administrator, refer to section 6 for 
information on updating the VistaLINK® PRO Server Jar File. 
 
Open VistaLINK® PRO and click on the refresh tree icon. Expand the hardware tree by clicking on the 
“+” button. Your card should appear as a newly listed device under the IP address of the frame 
controller for the frame that the 7800DA7-MADI is installed in.  
 
Please consult your network administrator if you continue to have problems connecting the card with 
VistaLINK® PRO, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical 
support. 
 
 

 

NOTE: When using VistaLINK® PRO it is important to ensure that the most recent 
7800DA7-MADI “.JAR” control file is installed.  See Section 6 for details on how to 
upgrade the 7800DA7-MADI VistaLINK® PRO JAR files. 

 
4.1. VISTALINK® PRO INTERFACE 
The 7800DA7 series products are controlled using VistaLINK® PRO. VistaLINK® PRO operates using 
Ethernet and SNMP control protocols. The 7800DA7 series modules do not have card edge controls. 
As a result, frame controller modules must be installed in all frames that house 7800DA7-MADI 
modules. 
 
Within VistaLINK® PRO the 7800DA7 series modules have a set of system configuration controls which 
can be accessed by right-clicking on the module in the VistaLINK® PRO hardware tree, and selecting 
“View Configuration…”.  
 

 
Figure 4-1: VLPro – View Configuration 
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4.2. GENERAL 

 
Figure 4-2: VLPro - General Tab 

Card Status 
Card Type: This field will display the card name that is read from the module. 

 

4.3. CONTROL 

 
Figure 4-3: VLPro - Control Tab 

 
Control 

Reclocker Bypass: This control allows the user to set the reclocker bypass mode. Selecting Auto 
mode will cause the reclocker to be auto-bypassed when the PLL is not locked. Selecting Force mode 
will cause the reclocker to be bypassed all the time. 

 
Monitor  

Master Jumper: This field displays to the user the current status of the master jumper, as either 
Local or Remote. 

 

4.4. FAULTS 

 
Figure 4-4: VLPro - Faults Tab 

 
Input Signal Lock: This Fault indicates to the user when the Input Signal is no longer locked. By the 
Trap Status turning red, the user knows that the input signal is no longer locked and there is a fault. If 
the Trap Status is green, there is no fault and the input signal is locked.  
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5. UPGRADING THE FIRMWARE  

5.1. CHECKING FIRMWARE VERSION ON THE 7800DA7-MADI  

From time to time, the 7800DA7-MADI will need to be upgraded with the latest information (“image”) to 
maintain the most up-to-date monitoring and control capabilities. 
 
Ensure that the 7800DA7-MADI is running the latest firmware, to check this simply right click on 
the cards address in VLPro Client and select Version Information.  
 

 
Figure 5-1 – Version Information  

 

5.1.1. Downloading the 7800DA7-MADI Image 
1. Download the image file ” 7800DA7-MADI Image File”. To retrieve the firmware contact your 

Evertz sales representative or check Evertz web site for availability (www.evertz.com – 
Support> Downloads > Firmware Downloads link > Type “7800DA7-MADI” in the Model search 
and press “Go”). Save the files to the hard drive. 
 

 
Please contact Evertz for image file if it not available on Evertz web site. 

 
2. Unzip the downloaded file and store the .bin file in a selected sub-directory. Record the location 

of the stored file. 
 
The 7800DA7 image can be upgraded by a couple different procedures, which are outlined in sections 
5.2 and 5.3, 
 
 
 
  

http://www.evertz.com/


7800DA7-MADI Series  
1x7 MADI Audio Reclocking Distribution Amplifier  
 

Page - 10 Revision 1.0  

5.2. REMOTE UPGRADE PROCEDURE USING VistaLINK® 

To perform the remote upgrade for the 7800DA7 you will need the following setup: 
 

• A working install of a VistaLINK® Pro client or VLPRO-C that’s version 10.0.7 or greater. 
• A downloaded and unzipped image file (.bin file) in section 5.1.1. 
 

 

The DHCP mode should be disabled on the frame controller before proceeding 
with the 7800DA7-MADI upgrade. To disable your DHCP refer to frame controller 
manual.  

 
 

5.2.1. Upgrading the 7800DA7-MADI Image using VistaLINK® 

 
• Use the right-click mouse button on the ‘7800DA7-MADI’ in the tree and select Version 

Information …’ option. 
 
• Open hardware tree and select card to be upgraded  

 
• Check mark card or cards to be upgraded. 

 
• Click the ‘Upgrade’ button on bottom right corner 

 
• Click the ‘Browse’ button to select the unzipped 7800DA7-MADI Image .bin file, which was 

downloaded in section 5.1.1. 
 

• Click the ‘Upgrade’ button and wait for the upload to complete.  This will take approximately 5 to 
10 minutes depending on network traffic. 

 
Upon completion, the 7800DA7-MADI module will reboot automatically and return online in normal “run” 
mode. 
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5.3. UPGRADING SERIALLY THROUGH THE COM PORT 
5.3.1. Setting the 7800DA7-MADI to Upgrade Mode 
The RS232 serial port connector J24 located at the front of the module is used when “image” upgrades 
are being done to the module.   
 

5.3.2. Setting up the Serial Baud Rate 
Open TeraTerm and set up the Baud Rate for communication as follows on the COM port that is being 
used: 
 

 
Figure 5-2: Baud Rate Settings on COM port 
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5.4. UPGRADING IN UPGRADE MODE 
For normal operation, the jumper J16 is set in the RUN position. To upgrade the firmware in the module 
unit pull it out of the frame.  Move Jumper J16 into the UPGRADE position. Reinsert the module into its 
slot. 
 
Make sure to put J16 back to the RUN position when upgrade is complete.  
 

5.4.1. Viewing Upgrade Information  

• Booting information will then be sent to the Tera Term window.  After the card powers up the 
“UPLOAD FILE NOW” message is displayed.  

 

 
Figure 5-3: Serial Port - Viewing Upgrade Information 

 
 

• Using XMODEM select to ‘Send’. 
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Figure 5-4: Serial Port – Sending via XMODEM 

 
• Locate the unzipped image file and select ‘Open’.  File will now download.  This may take 

several minutes.  
 

  
Figure 5-5: Serial Port – Selecting File for Upload 
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Select image file downloaded and unzipped in section 5.1.1 and upload file.  Module will automatically 
reboot.   
 
Make sure to put J16 back to the RUN position when upgrade is complete.  
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6. JAR UPGRADE PROCEDURES 

6.1. VISTALINK PRO JAR FILE UPGRADE 
Evertz products are constantly evolving and new features are often added. It is therefore important to 
update the JAR files in use to provide access to all the latest features or enhancements. It will also be 
necessary to add JAR files for new products. If your new product has not appeared even after waiting a 
few minutes for the Ethernet switch negotiation to complete, then it is possible that your JAR file may be 
old or missing. 
 
 
Download the JAR file ”7800DA7-MADI”. To retrieve the JAR file contact your Evertz sales 
representative or check Evertz web site for availability (www.evertz.com – Support> Downloads 
VistaLINK® PRO  JAR File Downloads>  > Type “7800DA7-MADI” in the Model search and press “Go”). 
Save the files to the hard drive. 
 
 

 
 

 
Please contact Evertz for JAR file if it not available on Evertz web site. 

 
 
To perform a JAR update, ensure that all VistaLINK® PRO clients are closed (those clients which are 
not closed will automatically be disconnected as soon as the VistaLINK® PRO Server is restarted). 
Maximize the VistaLINK® PRO Server window from the Windows task bar.  A window will appear, as 
shown in Figure 6-1.   

http://www.evertz.com/
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Figure 6-1: VistaLINK® PRO Server  

 
Select Help> Apply Update> Product from the menu. A window will appear, as shown in Figure 6-2: 
VistaLINK® PRO Server, navigate to the location of the new JAR file and double click to select the file. 
The window will automatically close and the update will be applied in the background.  
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Figure 6-2: VistaLINK® PRO Server – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 
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 
NOTE: You may confirm that all updates have been successfully applied by 
selecting from the menu Tools>View>Show/Hide Product update log. 

 
 
From the menu, shutdown the server by selecting File>Shutdown Server. Now re-open the server, it is 
normal for the start-up to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VistaLINK® PRO Clients. As the Client restarts you will experience a short 
delay while the update is applied. A prompt will appear confirming that the updates have been applied. 
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